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LISTED L.TE. E258913

This Class B digital apparatus
complies with Canadian ICES-003

Cet appareil numérique de la
Classe B est conforme a la
norme NMB du Canada.

Olivetti
My_Way Plus

FCC ID : DYKMYWAYPLUS06
IC : 2147B-MYWAYP06

This device complies with Part 15 of the FCC
Rules and RSS-210 of Industry Canada. Operation
is subject to the following two conditions: (1) this
device may not cause harmful interference, and
(2) this device must accept any interference
received, including interference that may cause
undesired operation,

DICHIARAZIONE CE DI CONFORMITA' del COSTRUTTORE secondo EN45014
MANUFACTURER’S CE DECLARATION of CONFORMITY according to EN 45014

OLIVETTI S.p.A Via Jervis, 77 - IVREA (TO) - ITALY

Dichiara sotto la sua responsabilita' che:
Declares under its sole responsibility that:

il prodotto descritto in questa guida
the product described in this guide

soddisfa i requisiti essenziali di Compatibilita Elettromagnetica e di Sicurezza previsti dalle Direttive:
fglﬁlls‘the essential requirements of Electromagnetic Compatibility and of Electrical Safety as prescribed by the
irectives:

89/336/CEE del 3 maggio 1989 con successive modificazioni (Direttiva 92/31/CEE del 28 aprile 1992 e

Direttiva 93/68/CEE del 22 luglio 1993);

89/336/EEC dated 3rd May 1989 with subsequent amendments (Directive 92/31/EEC dated 28th April 1992 and Directive
93/68/EEC dated 22nd July 1993);

73/23/CEE del 19 febbraio 1973 con successive modificazioni (Direttiva 93/68/CEE del 22 luglio 1993),
73/23/EEC dated 19th February 1973 with subsequent amendments (Directive 93/68/EEC dated 22nd July 1993),

in quanto progettato e costruito in conformita alle seguenti Norme Armonizzate:
since designed and factured in compliance with the following European Harmonized Standards:

EN 55022/A2 : 2003 (Limits and methods of measurements of radio interference characteristics of Information
Technology Equipment) / Class B;

EN 61000-3-2/A1: 2002 (Electromagnetic Compatibility (EMC) - Part 2 : Limits - Section 2 : Limits for
harmonic current emissions (equipment input current < 16 A per phase);

EN 61000-3-3/A1: 2002 (Electromagnetic Compatibility (EMC) - Part 3 : Limits - Section 3 : Limitation of
voltage fluctuations and flicker in low voltage supply systems for equipment with rated current up to and
including 16A);

EN 55024/A1 : 2002 (Electromagnetic Compatibility — Information technology equipment — Immunity
characteristics — Limits and methods of measurement);

EN 60950 —1 : 2001 (Safety of Information Technology Equipment, including electrical business equipment).

I modelli provvisti di interfaccia Wireless, sono inoltre conformi alle seguenti normative:
Moreover the models with Wireless interface are in compliance with following Standards:

ETSI EN 300-328 : 2004 Electromagnetic compatibility and Radio spectrum Matters (ERM);

Wideband transmission systems; Data transmission equipment operating in the 2,4 GHz ISM band and

using wide band modulation techniques; Harmonized EN covering essential requirements under article 3.2 of the
R&TTE Directive

ETSI EN 301-489 : 2002 Electromagnetic compatibility and radio spectrum Matters (ERM); Electromagnetic
compatibility (EMC) standard for radio equipment and services; Part3: specific conditions for Short-Range
Devices (SRD) operating on frequencies between 9 KHz and 40 GHz.

11 prodotto € inoltre conforme ai requisiti essenziali ed altre disposizioni pertinenti stabilite dalla direttiva
1999/5/CE

Moreover the model complies with the essential requirements and other relevant provisions of
Directive 1999/5/EC

La dcorgformité ai suddetti requisiti essenziali viene attestata mediante l'apposizione della Marcatura CE sul
prodotto. . .
Compliance with the above mentioned essential requirements is certified by the CE mark affixed to the product.

Olivetti S.p.A.

Note: 1) La Marcatura CE ¢ stata apposta nel 2006
Notes: 1) CE Marking has been affixed in 2006
2) 1l Sistema della Qualita ¢ conforme alle norme serie UNI EN ISO 9000.
2) The Quality System is in compliance with the UNI EN ISO 9000 series of Standards
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GETTING STARTED

OVERVIEW

This product carries out the functions of a high quality ink-jet portable printer and is characterized by
reduced weight and wireless operating mode.

The printer is fitted with a 3-colour ink cartridge for high quality printing of photographs on photographic
paper or plain paper without borders.

The printer can be powered with rechargeable batteries and is equipped with a Bluetooth interface for
wireless connection from a mobile phone, to become an inseparable companion during your leisure time.

It can be used in the handy PC-free or stand-alone mode in which it is possible to print 10x15 cm (4"x6")
format photographs simply connecting a PictBridge-compatible, DPOF or non PictBridge/DPOF digital
camera to the USB interface, without having to connect the printer to a computer and therefore without
having to switch on the PC. It is also possible to insert memory cards in the related slots on the side panel of
the printer for selection and printing of the photos saved.

Photographs can be printed directly from a mobile phone via wireless technology using the Bluetooth
interface integrated in the printer.

The printer can be connected to a personal computer on the second USB interface.

In this case, as in PC-free mode, the Olivetti Toolbox application can be used for fast access to all available
capabilities, to use the document management software and the additional software available on the
"Installation" CD-ROM.

note: If you want to connect the printer to a personal computer, this must use the Microsoft Windows 98
SE, Me, 2000 or XP operating system, or MAC OS X 10.2 or higher.

SAFETY INSTRUCTIONS

Carefully read and follow the information indicated below:

Connect the power cord to an electrical outlet that is near the product and easily accessible.

Do not use your printer near water or with wet hands.

Do not expose your printer to rain or moisture.

Do not attempt to disassemble your printer.

Observe all warnings and instructions marked on your printer.

Read and understand all the documentation that came with your printer.

note: This product works correctly and complies with safety norms when used with the AC power supply
unit provided by the manufacturer. When using different power sources than those provided in the product
packaging, it will be the user’s responsibility to guarantee compliance with safety norms and with the correct
power ratings that this product requires.

2 QUICK REFERENCE GUIDE

éﬁp

’
%



" é Quick Ref Guide_GB.fm Page 3 Wednesday, April 18, 2007 2:37 PM

Ay

I

INFORMATION ABOUT PRINT QUALITY AND THE WARRANTY
To guarantee the correct operation of your printer and top quality printing, it is essential to use only Olivetti
original ink cartridges.
Olivetti declines any responsibility for damage to your printer caused by the tampering with, or refilling of,
the ink-jet cartridges. Such actions also imply forfeiture of the Warranty.
FINDING INFORMATION
Part Description
Setup Diagram Located in the printer box, this document provides the instructions for setting up
your printer.
Quick Reference Guide This printed document provides the basic information needed to get you started
right away.
User Guide Provided on the “Installation” CD-ROM, this document comes in a PDF format
SO you can print it at your own convenience. With respect to the Quick
Reference Guide, it includes an overall view of your printer’s components and
troubleshooting information. To access the User Guide from Windows, click
Start > Programs or All programs > Olivetti > MY_WAY Documentation.
2 Online Help Provided on the "Installation" CD-ROM, the Online Help is automatically

installed on your computer during the installation of the drivers. It provides more
detailed information regarding the use of the printer and can be consulted by
clicking the Help button in the dialogue boxes.

Dialogue box Help Click the Help button in the software dialogue boxes to view information
regarding the screen that you are currently using.

Warranty Card Provided in the printer packaging, the Warranty Card provides product warranty
conditions and contact information for product servicing.

QUICK REFERENCE GUIDE
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INSTALLATION OF THE PRINTER WITH BLUETOOTH INTERFACE

When Bluetooth functionality is active on the printer, you can directly print your photos wireless. Bluetooth
as an operational radius of approximately 10 metres but can vay depending on the characteristics of the
invironment in which it is installed. The printer supports the Bluetooth 1.2 Class 2 communication system for
connection to compatible computers and mobile phones.

ACTIVATING BLUETOOTH

The printer is configured for Bluetooth operation from compatible mobile phones and does not require any
type of installation.

To verify whether the Bluetooth capability is available, check that the blue LED of the Bluetooth icon is ON.

If the blue LED of the Bluetooth icon is OFF, proceed as follows:

In the Windows Environment:

Perform USB installation as described in the “Setting up your printer” guide.

note: If installation has already been performed, it is not necessary to repeat it.

Open the Toolbox program (Start > Olivetti > Programs > Toolbox).

note: The USB cable must be connected and the printer must be ON.

Click the Settings button and then Bluetooth Settings to access configuration of Bluetooth parameters.
Enable Bluetooth mode and click Send settings: wait for the automatic reception of the data of the
Bluetooth network present: the blue light on the printer comes on.

Close the Toolbox program.

The printer is now enabled to operate in the Bluetooth environment. If a password is requested during the
connection phase, type 0000 (or other, if previously set).

In the Mac OS X Environment:

Perform USB installation as described in the “Setting up your printer” guide.

note: If installation has already been performed, it is not necessary to repeat it.

Run the Toolbox program from the desktop.

note: The USB cable must be connected and the printer must be ON.

Click the Settings button and then Bluetooth Settings to access configuration of Bluetooth parameters.
Click Bluetooth Status. Activate Bluetooth mode and wait for the automatic reception of the data of the
Bluetooth network present: select Apply.

Close the Toolbox program.

The printer is now enabled to operate in the Bluetooth environment. If a password is requested in the
connection phase, type 0000 (or other, if previously set).

4 QUICK REFERENCE GUIDE
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PRINTER CONTROL PANEL

Reference

},
1
2
3
4
5

[

+

Item Description

On/Off button Used to turn the printer ON and OFF.

Out of ink indicator Flashes or lights up to indicate that the ink cartridge is running out; in
this case, it is suggested to replace the cartridge. See "Replacing the
ink cartridge".

Paper error indicator e Lights up to indicate that the paper is out.

¢ Lights up to indicate jamming of the paper.
e Lights up to indicate feeding of an incorrect paper format during
printing

Magic button Press to improve image quality. The new image generated is not
displayed on the display or saved but is available for printing.

Cancel button Cancels the print job underway causing the paper to be ejected and
the restoral of the default settings.

QUICK REFERENCE GUIDE 5
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Reference Item Description
6 Select button Press this button to select the photo displayed on the LCD.
7 Print button Press this button to print the photos selected. This button flashes

during printing.

8 Page layout button Press to select the layout with which the photos are to be printed on
paper. Press this button sequentially to select:

e 1 borderless photo adapted to the format of the sheet.

e 1 photo with borders adapted to the format of the sheet.

e 2 borderless photos adapted to the format of the sheet.

e 4 borderless photos adapted to the format of the sheet. The
index of your images will be printed correctly if already compiled
by the peripheral (digital camera). If the image index is not
provided by the peripheral, the printer will create its own index
which may not be complete.

Only the icon selected remains ON.

9 Number of copies e Press the button with the (+) sign to increase the number of
button copies to be made (max. 9).
e Press the button with the (-) sign to reduce the number of copies
to be made (min. 1).
The number selected is displayed in the bottom right-hand corner of
the image selected.

10 Navigation button Makes it possible to move between the images displayed, shifting a
white highlight frame. Hold the button down for automatic scrolling
from one image to another.

11 Display button Press this button to switch from full screen to index (3x3 images)
display.

12 Colour display 2.4" LCD display for image preview and selection.
Active Display

The bar of the icons which highlights the total number of images
selected for printing to the right and the icon that represents the
device connected to the left is present in the lower part of the

display.
13 Bluetooth activity Comes on at printer power-on if the Bluetooth function is enabled.
indicator Flashes during file transfer from a Bluetooth peripheral to the printer.

6 QUICK REFERENCE GUIDE
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LOADING PAPER

Loading Paper in the Paper Cassette

Open the paper cassette lid.

Load up to 20 sheets of photo paper in the paper cassette bay with the print or glossy side facing upward,
adjusting the paper width guide accordingly. Close the paper cassette lid.

Open the printer’s left outer door by pressing the upper centre part of the door to release it. Insert the paper
cassette into the insertion slot and press it firmly until it clicks into place.

Loading a Single Sheet of Plain A4 Paper Folded Vertically in the Middle

You can manually load a single sheet of A4 plain paper folded vertically, which corresponds to a double A6
size format (105 x 297 mm).

Make sure that your printer is turned on and that the paper cassette is inserted. See “Turning On Your
Printer”.

Fold a sheet of plain A4 size paper vertically in the middle. Place the paper between the two paper guides on
the top of the paper cassette and feed the leading edge of the sheet into the insertion slot until it is picked
up by the printer's feed mechanism.

QUICK REFERENCE GUIDE 7

-t

y N

P

S | L



Ay

I

= T

\ é Quick Ref Guide_GB.fm Page 8 Wednesday, April 18, 2007 2:37 PM

CHOOSING THE POWER SOURCE FOR YOUR PRINTER

You can power your printer from the mains electrical power supply by using the external AC power supply
unit provided, from your automobile battery by using the car lighter DC adapter provided, or with six
rechargeable AA size 1.2 V Nickel Metal Hydride (NiIMH) batteries, with a capacity of at least 2.2 to 2.5 Ah
each, that you can purchase from electronic stores or from large retailers. The batteries must be fully
charged when inserted in the printer.

note: The printer will not charge your rechargeable batteries. You can also order an Olivetti battery charger
kit by phoning a hot-line number listed in the leaflet that came with the printer, provided in the printer
software or in the Olivetti web site.

Mains Electrical Power Supply

Insert the external AC power supply unit cable jack into the printer’s power socket, then insert one end of
the power cord into the power supply unit and the other end to an electrical wall outlet.

8 QUICK REFERENCE GUIDE
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12V Car Battery DC Power Supply

1 Plug one end of the car lighter DC adapter into the printer power socket and the other end into your
automobile’s 12V cigarette lighter.
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Rechargeable NiMH Batteries

1 Turn over your printer and then open and remove the battery compartment cover.
2 Insert six rechargeable AA size 1.2 V Nickel Metal Hydride (NiIMH) batteries, with a capacity of at least 2.2 to
2.5 Ah each, in the battery compartment then replace and close the compartment cover. The batteries must
. be fully charged when inserted in the printer.
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TURNING YOUR PRINTER ON AND OFF

Turning On Your Printer

Press the ON/OFF button on the printer control panel.

The printer will execute a series of autodiagnostic tests aimed at detecting any possible system malfunction.
Any error detected at this time will be signalled by the control panel, or by the personal computer if
connected to the printer.

When you connect a non-PictBridge digital camera to the printer or insert a memory card in the appropriate
memory card slot, all of the icons on the control panel will illuminate. When you connect a PictBridge-
compliant digital camera only the Print button will turn off to indicate that printing is controlled directly from
the attached digital camera.

Turning Off Your Printer

To turn off your printer when you finished working with it, press the ON/OFF button on the control panel. All
the lights on the control panel, and the LCD, will turn off.

CONNECTING A DIGITAL CAMERA TO YOUR PRINTER

Turn on your digital camera. Read your camera’s User’s Guide for more information.

With your printer powered on, plug one end of the digital camera’s USB cable to the USB connector on the
camera.

Open the printer’s left outer door by pressing the upper centre part of the door to release it. Plug the other
end of the USB cable into the printer’s USB connector.

note: When you connect a PictBridge-compliant digital camera to your printer, the print icon on the control
panel will turn off to indicate that printing will be controlled directly from the digital camera. Read your
camera’s User's Guide for instructions on how to print your photos.

10 QUICK REFERENCE GUIDE
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INSERTING AND REMOVING MEMORY CARDS
e When inserting a Compact Flash card, make sure that the label is facing upward (if the label has an arrow it
needs to be pointing towards the printer) with the metal pinholes entering the printer first.
e When inserting a Multimedia and SecureDigital cards, make sure that the angled corner is on the right and
the metal contacts are facing downward.
e When inserting a SmartMedia card or a Memory Stick, make sure that the angled corner is on the right and
the metal contacts are facing upward.
e When inserting a xD-Picture Card, make sure the curved side of the card is facing you and the metal contacts
are facing downward.
Proceed as follows:
1  Open the printer’s left outer door by pressing the upper centre part of the door to release it, so you can
access the memory card slots.
2 Orient your specific memory card as indicated at the beginning of this section, carefully insert it into the
selected slot and then gently push it in until it stops.
note: If the memory card does not go in all the way, do not try to force it in since doing so will damage the
card and the printer.
note: If the card is inserted correctly, an icon is displayed on the LCD indicating the total number of photos
stored on the memory card (only the compatible files are opened and counted).
{

Removing a Memory Card

1 Carefully pull the card completely out of its slot. To remove a Compact flash card, push the extraction button
located on the side of the insertion slot.
CAUTION: DO NOT remove the memory card while it is still being accessed either by the printer or
personal computer. Doing so could damage the photos stored on the card.
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USING YOUR PRINTER WITHOUT A COMPUTER

VIEWING PHOTOS ON YOUR PRINTER’S DISPLAY

Full-Screen Views

1\

5\

[

4/
3
Reference Item Description
1 Browse window Displays the current photo.
2 Select frame Indicates the selection state, highlighted when the Select button is
pressed to select the photo displayed.
3 Image Total field Indicates the number of selected photos that you want to print.
4 Device icon Indicates the device connected.
5 Icon bar The bar where the different icons reside.

Navigating Through Full-Screen Views and Selecting Photos

To scroll through all the photos that are stored on the connected storage device and displayed in this screen
view, press the Right and Left Navigation button.

To select the photo displayed and that you want to print, press the Select button.

To deselect the photo displayed, press the Select button again.

12 QUICK REFERENCE GUIDE
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Thumbnail Views
2
\
G -
7 =
\
| e
6/ \
5
Reference  Part Description
1 Photo indicator Indicates how many compatible photos are stored on the connected
device.
)} 2 Select frame Indicates that the photo was selected by using the Select button.
3 Browse frame Highlights the current image as a result of the of the pressing of the
Navigation button.

4 Thumbnail grid A total of 9 grids where the photos are displayed in miniature format.
5 Image total field Indicates the number of photos that you want to print.
6 Device icon Indicates the device connected.
7 Icon bar The bar where the different icons reside.

IMPROVING THE PRINT QUALITY OF YOUR PHOTOS

You can improve the print qualty of your photos by using the Magic button.

1 Press the Magic button. The printer analyzes the images and makes the necessary corrections.
note: The results of these operations are not shown on the LCD to avoid altering the original photo but are
visible in print only.
2 To print the modified photos, keep the Magic button selected and press the Print button.
QUICK REFERENCE GUIDE 13
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SELECTING AND PRINTING PHOTOS FROM YOUR MEMORY CARD

Open the printer’s left outer door by pressing the upper centre part of the door to release it, then insert the

memory card that you wish to print from into the related slot. The file transfer screen is displayed on the LCD

indicating that your printer is reading the compatible files stored on the connected memory card.

A screen indicating the total number of compatible photos stored on the memory card is displayed on the

control panel LCD. If needed, press the Change View button to toggle between full-screen and thumbnail

screen views. See "Viewing Photos on Your Printer’s Display". An icon on the screen’s icon bar will indicate

the device connected.

Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the highlighted

frame on the photo that you want to print.

Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus (-)

button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate the

number of copies requested for that photo. The total number of photos selected is displayed on the icon bar

on the bottom of the screen.

Select the layout in which you wish to print the selected photos by pressing the Page Layout button the

number of times needed to select the required layout. You have the following possibilities:

— Print an index sheet of all the photos if "All photos" was selected (by clicking the icon showing the total
number of photos stored on the memory card).

— Print 4 borderless photos fitted on the page size.

— Print 2 borderless photos fitted on the page size.

— Print 1 photo with borders and fitted on the page size.

—  Print 1 borderless photo fitted on the page size.

Open the printer’s right outer door by pressing the upper centre part of the door to release it.

Press the Print button to print the selected photos. The illuminated button icons will go off, the photo

processing screen is displayed on the LCD. Upon completion of the print job, the initial screen indicating the

number of photos stored will be redisplayed.

PRINTING PHOTOS FROM YOUR PICTBRIDGE-COMPLIANT DIGITAL CAMERA

note: Before proceeding, make sure that your digital camera is PictBridge-complaint by reading the camera’s
User’s Guide.

Load the paper on which you want to print. For optimum results when printing photographs, use photo
paper.

note: If the size of the paper loaded in the printer is different than the paper size selected from the digital
camera for printing and you begin to print, the printed output will be wrong.

Only a paper size smaller than the size selected from the digital camera will interrupt the print job and cause
the Print button on the control panel to illuminate. Load the correct paper and press the Print button to
resume printing.

Open the printer's right outer door by pressing the upper centre part of the door to release it.

Make sure your PictBridge-compliant digital camera is turned on and connected to the printer.

Printing is managed directly by your camera, so read your camera’s User’s Guide for instructions on how to
print your photos.

During printing, the Print button will flash to indicate that a print job is under way.

14 QUICK REFERENCE GUIDE
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SELECTING AND PRINTING PHOTOS FROM YOUR DPOF DIGITAL CAMERA

Your printer is capable of recognizing the DPOF information associated to picture files. In the case of a DPOF

digital camera, the printer will print the photos that you select directly from your camera.

note: Before proceeding, make sure that your digital camera is DPOF-complaint by reading the camera’s

User's Guide.

Load the paper on which you want to print. For best results when printing photographs, use photo paper.

note: If the size of the paper loaded in the printer is different than the paper size selected from the digital

camera for printing and you begin to print, the printed output will be wrong.

Only a paper size smaller than the size selected from the digital camera will interrupt the print job and cause

the Print button on the control panel to illuminate. Load the correct paper and press the Print button to

resume printing.

Open the printer’s right outer door by pressing the upper centre part of the door to release it.

Make sure your DPOF digital camera is turned on and connected to the printer.

If you associated DPOF information to the photo files stored in your camera’s memory, the printer will

automatically print the photos that you have selected. Read your camera’s User’s Guide for instructions on

how to select the photos you want to print.

If you did not associate DPOF information to the photo files, a screen indicating the total number of photos

stored in the digital camera’s memory is displayed on the control panel LCD. If needed, press the Change

View button to toggle between full-screen and thumbnail screen views. See "Viewing Photos on Your

Printer's Display" for information regarding the views and indications displayed on the LCD. An icon

displayed on the screen’s icon bar will indicate the device connected.

Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the highlighted

frame on the photo you want to print.

Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus (-)

button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate the

number of copies requested for that photo. The total number of photos selected is displayed on the icon bar

on the bottom of the screen.

Select the layout in which you wish to print the selected photos by pressing the Page Layout button the

number of times needed to select the required layout. You have the following possibilities:

— Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing the
total number of photos stored on the memory card).

— Print 4 borderless photos fitted on the page size

— Print 2 borderless photos fitted on the page size

— Print 1 photo with borders and fitted on the page size

— Print 1 borderless photo fitted on the page size

Press the Print button on your printer’s control panel to print your photos. For more information see “Printer

Control Panel”.
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SELECTING AND PRINTING PHOTOS FROM YOUR NON-PICTBRIDGE/DPOF DIGITAL CAMERA

Load the paper on which you want to print. For optimum results when printing photographs, use photo

paper.

Open the printer's right outer door by pressing the upper centre part of the door to release it.

Make sure your digital camera is turned on and connected to the printer.

A screen indicating the total number of photos stored in the digital camera’s memory is displayed on the

control panel LCD. If needed, press the Change View button to toggle between full-screen and thumbnail

screen views. See "Viewing Photos on Your Printer’s Display" for information regarding the views and

indications displayed on the LCD. An icon displayed on the screen’s icon bar will indicate the device

connected.

Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the highlighted

frame on the photo you want to print.

Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus (-)

button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate the

number of copies requested for that photo. The total number of photos selected is displayed on the icon bar

on the bottom of the screen.

Select the layout in which you want to print the selected photos by pressing the Page Layout button the

number of times needed to select the required layout. You have the following possibilities:

— Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing the
total number of photos stored on the memory card).

—  Print 4 borderless photos fitted on the page size.

—  Print 2 borderless photos fitted on the page size.

— Print 1 photo with borders and fitted on the page size.

—  Print 1 borderless photo fitted on the page size.

Press the Print button on your printer’s control panel. The photos stored in the memory of your camera will

be printed.

PRINTING PHOTOS FROM A BLUETOOTH PERIPHERAL

Your printer is equipped with an integrated Class 2 Bluetooth component.

Its default address is 0000 so it can directly print any .JPEG transmitted from a Bluetooth mobile phone or
personal computer located within a maximum distance of 10 meters from the printer.

note: You can change your printer’s default Bluetooth address from your personal computer, if connected to
the printer.

Open the printer’s right outer door by pressing the upper centre part of the door to release it.

Make sure that paper is loaded in the printer.

Turn on your printer. Bluetooth functionality is automatically activated on your printer.

Turn on the Bluetooth peripheral that you want to print from and, from within a distance of 10 meters from
the printer, launch a Bluetooth discovery procedure directly from your peripheral. By activating this
procedure, your Bluetooth peripheral will search for another Bluetooth device in the vicinity (in this case,
your printer) with which it can share data. For information on how to launch a Bluetooth discovery
procedure, read your peripheral’s User’s Guide.
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5  When your Bluetooth peripheral has discovered your printer, launch the print job directly from your
Bluetooth device. For instructions, read your peripheral’s User's Guide.
The Bluetooth activity indicator on the control panel will flash as the photos are being transferred from the
Bluetooth device to your printer for printing. The photos will be printed without borders.

Ty

THE INK CARTRIDGE

CHECKING THE INK LEVEL

To know when the ink cartridge is running out of ink and needs replacing, check the cartridge’s ink level
condition directly on the printer control panel:

e When the ink indicator begins to flash, the ink level in the cartridge is getting low; when the indicator is on
steady, the ink cartridge is almost out of ink.

INFORMATION NEEDED WHEN PURCHASING THE INK CARTRIDGE

To guarantee the correct operation of your printer and top quality printing, it is essential to use only Olivetti
original ink cartridges. Your printer uses the ink cartridge indicated below. Use the following product code
when purchasing the cartridge:

e Tri-colour ink cartridge, code INP0S.

REPLACING THE INK CARTRIDGE

\ Before proceeding with the procedures indicated in this section, carefully read and follow the information 4

provided in "Safety Instructions" at the beginning of this manual.

For information on how to purchase new ink cartridges from the manufacturer, consult the Toolbox’s

Solutions and Assistance feature. To access the Toolbox, see “The Toolbox”. To guarantee the correct

operation of your printer and top quality printing, it is essential to use only the manufacturer’s original ink

cartridges.

Turn on the printer.

Make sure that paper is loaded. See "Loading Paper".

Open the printer’s right outer door by pressing the upper centre part of the door to release it, then pull open

the printer’s right inner door. The ink cartridge carrier moves to its loading position at the far right-hand side

of the carriage.

4  With your index finger, pull and rotate downward the top edge of the ink cartridge and remove it from the
carrier.

5 If you are installing a new ink cartridge, remove the cartridge from its box and then gently remove the
protection tape that covers the ink nozzles. DO NOT TOUCH THE CONTACTS or the ink nozzles. Hold the ink
cartridge by its sides.

6  Hold the ink cartridge with its nozzles facing downward and its contacts facing the rear of the printer, then
insert the cartridge into the carrier from the bottom nozzle side first and with a rotating motion.

7  Push the ink cartridge firmly inward until it clicks into place.

8  Close the printer’s right inner door.

If a new cartridge is installed, the printer will automatically perform a cartridge recognition procedure which
lasts about 3 minutes. An ink cartridge alignment page will then be printed to indicate that the newly
installed ink cartridge was automatically aligned.
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USING YOUR PRINTER FROM A COMPUTER

BEFORE YOU BEGIN

This chapter outlines the basic operating information that will put you in the condition to start using your
printer when connected to a computer.

Before you begin:

Make sure that your printer and personal computer are connected properly and that the software on the
“Installation" CD-ROM was successfully installed on the computer as indicated in the “Setting Up Your
Printer” guide provided with your printer.

Load the paper on which you want to print. For more information see “Loading Paper".

Make sure that the out of ink indicator on the control panel is not flashing, or not illuminated. If it is, it is
suggested that you replace the ink cartridge. For more information see “Replacing the Ink Cartridge".
Keep in mind that the buttons on your control panel are not active when the printer is used from the
Toolbox installed on your personal computer. Only the Cancel button can be used to interrupt a print job
underway.

THE TOOLBOX

The Toolbox application allows you to control printing operations directly from a single user interface on
your computer monitor.

Included in the “Installation” CD-ROM, the Toolbox is installed automatically on your computer when you
install the software contained on this CD-ROM.

To access the Toolbox:

Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is
displayed.

note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon present on
the desktop or by selecting it from the list of installed programs.
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The main area of the Toolbox includes the icons representing the different tools available.

Icon Toolbox: You can:

Print photos

Memory card file transfer

Browse the folders of your computer’s hard disk, the memory of the non-
Pictbridge/DPOF digital camera connected to your computer or the memory
card inserted in your printer to search for the folder containing photos to
print.

Select all the photos stored in the folder or just the individual ones wanted,
and choose how many copies to print.

Select the type of paper to print on, and its size.

Select whether to print the photos on a single page, two on one page or
four on one page.

Print an index sheet of photos.

Print the photos you have selected.

Transfer the contents of the memory card inserted in the printer to a folder
on your computer. See "Transferring Files from Memory Card to your
Computer".

The Toolbox main interface screen also provides links to Help, Solutions and assistance, and Settings.

Link Toolbox:

You can:

Il

Help

Solutions and assistance

Settings

20 QUICK REFERENCE GUIDE
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Read more information on the currently displayed topic.

Clean and test the ink cartridge.

Automatically align the ink cartridge.

Find the address of the manufacturer’s web site, where you can access the
information needed to purchase new ink cartridges.

Access troubleshooting information.

Access contact information.

Change the Toolbox default settings.
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THE PRINTER STATUS MONITOR
The Printer Status Monitor provides information on the current state of your printer. It is installed
permanently on your computer when you install the software contained on the "Installation” CD-ROM.
Displayed automatically at the beginning of a print job, the Status Monitor:
displays a graphical representation of the percentage of the print job already completed.
displays the page number being currently printed out of the total number of pages of the job.
displays the job title.
displays a graphical representation of the estimated amount of ink, in percentage, still available in the
cartridge.
allows you to cancel the print job.
provides you with the address of the manufacturer’s web site, where you can access the information needed
to purchase new ink cartridges.
The Status Monitor closes automatically at the end of the print job, but you can close it to its icon on the
Windows task bar at any time.
If you decide to close the Status Monitor during a print job, it will be automatically redisplayed in the
following conditions:
when the ink remaining in the cartridge is low, or when the cartridge is out of ink. A coloured exclamation
mark will indicate when the cartridge is in a low ink condition and the importance of the condition. Pop-ups
will be displayed with the address of the manufacturer’s web site, where you can access the information
needed to purchase a new ink cartridge
The Printer Status Monitor also displays error pop-ups when: ¥

your printer runs out of paper.

a paper jam has occurred.

your printer is busy with another task.

your printer is not recognised.

the ink cartridge carriage is jammed.

your printer does not work (printer error).

In all of the above error conditions, you can choose whether to continue or cancel the print job by clicking
the related button on the screen.
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PRINTING FROM YOUR APPLICATION USING PRINT PROPERTIES

With the document or photo open in the application that you are using, click File > Print to open the Print
dialogue box.

Click Preferences or Properties, depending on your operating system.

On the Paper/Quality tab, customise your print settings:

a

—

Document type: define the characteristics of the document that you want to print. Select Auto
detection to have the printer automatically detect the characteristics of the document, or Manual
selection to manually define the characteristics yourself.

If you select Manual selection, choose the characteristics of the document to be printed: Text (black

text or line art only), Mixed (combination of black text or line art and colour graphics or photos), or

Photo (colour photos only).

Paper Setup: from the drop-down menus available, select the type of paper that you want to use (Plain,

Coated, Photo, Glossy, Cards) and its size.

e If you select Coated or Cards as the type of paper you will be using, the Borderless checkbox is
displayed so you can choose to print without borders.

e If you select Photo or Glossy paper as your paper type, by default the Borderless checkbox will be
selected enabling you to print borderless photos on the selected media.

e If plain paper is selected the Manual Feed checkbox is already selected. In this case the printer will
not begin to print until you load the paper, and will automatically recognise the size of the paper
loaded. Plain A4 size paper folded in the middle can be fed only manually from the top of the paper
cassette.

nota: If you load paper that is smaller than the selection made, the printer will eject the paper

prompting you to load paper corresponding to the selected size.

Quality: define the quality of your printed output. Select between Speed (highest print speed, lowest

resolution), Normal (average print speed and resolution), High (low print speed, high resolution) and

Photo Quality (lowest print speed but with the highest print resolution).

e You can also select to print in Colour or in B/W (Black and white). By default the Colour radio
button is always checked, enabling full-colour printing. Select B/W when you need to print shades
of grey.

By default, the Print Last Page First checkbox is selected so upon completion of the print job the first

page of your multiple-page document remains on top of the document. Click this checkbox to deselect

it if you want to print starting from the first page of your document.

In the No. Copies box, use the up or down arrows to define the number of copies you want to print.

To return the different screen settings to their factory default values, click the Default button.

On the bottom of the screen:

e Click the OK button con confirm the settings made and exit.

e (lick the Cancel button to exit without saving the changes made.

e (lick the ? button for information on the Paper/Quality tab.
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Click the Layout tab to select the layout format of your printed output:

a The Single page per print radio button is selected by default. Your printer will print the individual
pages of the document, or your photos, on a single page layout.

b Click the Multiple pages per print radio button to fit the selected number of pages on a single sheet
of paper. By selecting this option:

e The Pages per print drop-down menu is displayed where you can select to print either 2 or 4 pages
of your document on a single sheet.

e The Order drop-down menu is then displayed where you can select the order in which the multiple
pages will be fitted on the single sheet of paper. You can select between Left-to-right down,
Right-to-left down, Right-to-down left or Left-to-down right, depending on the number of
pages selected.

e By clicking the Borders checkbox, a frame is placed around the individual page images on the single
sheet of paper.

¢ Click the Poster radio button to expand the contents of a single page onto more than one sheet of
paper. The final output consists of your selected poster image distributed among the number of pages
defined:

e The Poster drop-down menu is displayed where you can select 2x1, 2x2, 3x3 or 4x4 to define on
how many sheets to fit the selected poster image.

e By clicking the Print Borders checkbox, the printer will automatically place a frame around each
individual image that your poster is composed of. An indication of the position of the image in the
poster is also provided.

d To restore the different settings to their factory default values, click the Default button.

e On the bottom of the screen:

e (lick the OK button to confirm the settings made and exit.

e (lick the Cancel button to exit without saving the changes made.

e Click the ? button for information on the Layout tab.

Click the Ink Levels tab to see the estimated amount of ink still available in the ink cartridge. This is

important information to consider before launching a lengthy print job.

a On the Ink Levels tab there is also the Launch Toolbox button, a direct link to the Toolbox
Maintenance screen that provides a user interface for the maintenance and troubleshooting of your
printer. See "The Toolbox" for more information.

b On the bottom of the Ink Levels tab:

e (lick on the OK or Cancel button to exit.

e Click on the ? button for information on the Ink Levels tab.

Click the OK button in the Print dialogue box to start printing.
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PRINTING WITH THE TOOLBOX PRINT PHOTOS TOOL

Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY Toolbox, or

click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is displayed.

note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon present on

the desktop or by selecting it from the list of installed programs.

Click Print photos. The "My pictures" folder of your personal computer is opened by default if a digital

camera is connected; if a memory card is inserted, the folder with the contents of the memory card is

opened by default.

note: The printer directly prints the picture files stored on the memory card and therefore do not remove the

memory card from its slot while connection is in progress.

The pictures stored in the folder are displayed in thumbnails on the left of the dialogue box; the first photo

of the folder, or the photo that you click on, is displayed in a larger view on the right of the screen. You can

now select what to do:

a Click the Add All button to add all the photos in the folder to your selection of photos to print.

b Select the individual photos to print by clicking directly on the photo wanted. Define the number of
copies that you want to print of the photo selected by clicking on the plus (+) and minus (-) boxes that
appear on the selected photo. You can also select the number of copies by clicking on the copy selection
arrows on the bottom of the screen. The box on the left upper part of the selected photo indicates the
number of copies chosen. Use the box's side scroll bar or arrow buttons to move up and down through
the selection of photos available.

note: To remove all the photos from your print selection, click the Clear Selection button. To remove single

photo selections, click on the minus (-) box on the individual photos, or click the copy selection arrows on

the bottom of the screen, to decrease the number of copies to zero.

Click the Print button. The Print Photos dialogue box is displayed.

note: You can improve the quality of your photos by using the correction filters that are available in this

screen. To select the filter wanted, tick it's corresponding selection box. Once the filter is selected a preview

of the corrected photo is displayed.

Personalise your print settings:

a Paper setup: from the drop-down menu select the paper that you loaded and define its size.

b Quality: define the quality of your printed output. Select between Speed (highest print speed, lowest
resolution), Normal (average print speed and resolution), High (low print speed, high resolution) and
Photo Quality (lowest print speed but with the highest print resolution on photo paper).
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Layout: choose the layout that you prefer by clicking on the graphical representation of one of the
following options: Full Page, Two-in-One, Four-in-One and Index.

nota: The Borderless layout is not available if Plain paper type is selected.

nota: When the Two-in-One paper layout, if a 10x15 cm (4”x6") paper size is chosen, the printer
will print two wallet-sized pictures. When a Four-in-One paper layout is selected, if a 10x15 cm
(4"x6") paper size is chosen, the printer will print four passport sized pictures. When selecting an
Index layout, all of the pictures will be bordered.

Click the Print button to start printing.

TRANSFERRING FILES FROM A MEMORY CARD TO YOUR COMPUTER

Insert into the corresponding slot on the printer, the memory card containing the files to transfer. See
"Inserting and Removing Memory Cards".

Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY Toolbox, or
click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is displayed.

note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon present on
the desktop or by selecting it from the list of installed programs.

Click the Memory Card File Transfer icon.

Click the Browse button and search for the folder on your computer in which to transfer the files.

Click the OK button once you have found the folder wanted.

Click the Transfer button to start the file transfer from the memory card to your computer.

note: To cancel the file transfer and return to the Toolbox’s main screen, click the Cancel button. For
information, click Help.

CHECKING THE INK LEVEL FROM YOUR COMPUTER

To know when the ink cartridge is running out of ink and needs replacing, check the ink level in the
following ways:

By viewing the ink level indicator on the Ink Levels tab of your print driver’s Preferences or Properties
dialogue box, as follows:

a
b

C

With the document file open in the application that you are using, click File > Print. The Print dialogue
box is displayed.

Click Preferences or Properties, depending on your operating system. The printer driver user interface
screen is displayed.

Click the Ink Levels tab. The ink capacity indicator shows the percentage of ink remaining in the
cartridge.

From the Toolbox, by viewing the ink level indicator on the bottom of the Toolbox’s main screen:

a

Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is
displayed.

note: In the Mac OS X environment, the Toolbox program can be launched by clicking the icon present
on the desktop or by selecting it from the list of installed programs.

Click Solutions and assistance.

Click Select to choose New ink cartridge. The New ink cartridges dialogue box displayed includes the
ink level indicator showing the amount of ink remaining in the cartridge.
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From pop-ups displayed by the Printer Status Monitor during a print job, that show the amount of ink
remaining. See "The Printer Status Monitor" for more information.
From the Start menu:
a Click Start > Programs or All programs > Olivetti > MY_WAY New ink cartridge. The Status

Monitor is displayed.
Directly on the printer control panel:
When the ink indicator begins to flash, the ink level in the cartridge is getting low; when the indicator is on
steady, the ink cartridge is almost out of ink.
CARRYING YOUR PRINTER
Extract the paper cassette from its insertion slot on the right side of the printer and close the printer’s lleft
outer door.
Slide the paper cassette along the cassette rails on the bottom of the printer until it is locked in place by the
securing clip.

<€
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3 Extract the handle on the top of the printer and carry the printer wherever you go.
REMOVING THE PAPER CASSETTE FROM THE BOTTOM OF THE PRINTER

1 Turn over your printer.

2 Press the paper cassette securing feature and slide the cassette off the bottom of the printer.
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NOTICES

DIRECTIVE 2002/96/CE ON THE TREATMENT, COLLECTION, RECYCLING AND DISPOSAL OF
ELECTRIC AND ELECTRONIC DEVICES AND THEIR COMPONENTS

INFORMATION

1. FOR COUNTRIES IN THE EUROPEAN UNION (EU)

The disposal of electric and electronic devices as solid urban waste is strictly prohibited: it must be collected
separately. The dumping of these devices at unequipped and unauthorized places may have hazardous
effects on health and the environment. Offenders will be subjected to the penalties and measures laid down
by the law.

To dispose of our devices correctly:

a Contact the Local Authorities, who will give you the practical information you need and the
instructions for handling the waste correctly, for example: location and times of the waste
collection centres, etc.

b When you purchase a new device of ours, give a used device similar to the one purchased to

— our dealer for disposal.

The crossed dustbin symbol on the device means that:

e When it to be disposed of, the device is to be taken to the equipped waste
collection centres and is to be handled separately from urban waste;

e The manufacturer guarantees the activation of the treatment, collection,
recycling and disposal procedures in accordance with Directive 2002/96/CE (and
subsequent amendments).

2. FOR OTHER COUNTRIES (NOT IN THE EU)

The treatment, collection, recycling and disposal of electric and electronic devices will be carried out in
accordance with the laws in force in the country in question.
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MIPC (Mobile Imaging and Printing Consortium)

The MIPC is a non-profit industry association founded in 2004 by leading companies in photo
printing and the mobile phone industry. Its mission is to promote and support the development
of interoperability guidelines enabling printing of images and other content between mobile
phones and printing devices. The guidelines are promoted for use internationally to ensure a
broad spectrum of products and services for mobile phone consumers.
www.mobileprinting.org

MY_WAY plus: This Mobile Printing Ready product is designed to provide easy printing
from mobile phones. This product follows Mobile Imaging and Printing Consortium (MIPC)
Implementation Guidelines for Printing with Mobile Terminals, Version 1.0, for: Bluetooth,
PictBridge, Memory Card.

EMISSIONS NOTICES

Federal Communicaions Commission (FCC) compliance information statement

The Olivetti MY_WAY Plus has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions:
this device may not cause harmful interference, and

this device must accept any interference received, including interference that may cause undesired
operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference in a
residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation.

if this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for any radio or television interference caused by using other than
the recommended cables or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user’s authority to operate this equipment.
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Olivetti
My_Way Plus

FCC ID : DYKMYWAYPLUS06
IC : 2147B-MYWAYPO06

This device complies with Part 15 of the FCC
Rules and RSS-210 of Industry Canada. Operation
is subject to the following two conditions: (1) this
device may not cause harmful interference, and
(2) this device must accept an){1 interference
- received, including interference that may cause X
undesired operation.
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LISTED I.T.E. E258913

This Class B digital apparatus
complies with Canadian ICES-003

Cet appareil numérique de la
Classe B est conforme a la
norme NMB du Canada.
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